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Introduction 
 

Welcome to SampleOptimizerÊ and SampleTrackerÊ! 

 

SampleOptimizerÊ represents the latest evolution in long term monitoring optimization 

(LTMO ) software.  For the first time, the power of true mathematical optimization has been 

applied to LTMO in an easy-to-use desktop software tool to reduce sampling redundancy. 

SampleOptimizerÊ is the culmination and combination of years of research in mathematical 

optimization, data analysis, and environmental engineering.  Experts in the fields of geology, 

hydrogeology, computer and environmental engineering, geostatistics, contaminant 

geochemistry, and remedial system optimization have applied their technical and field expertise 

to develop the sound approaches implemented in the software. 

 

SampleTrackerÊ is an additional software module that reviews new monitoring data against 

historical data.  The software identifies cases where current data deviates from expectations that 

are based on the historical dataset. 

 

ModelBuilderÊ is an additional component within the software that is utilized by the 

SampleOptimizerÊ module and, in some cases, by the SampleTrackerÊ module.  

ModelBuilderÊ has two sections: one for model fitting, visualization, and analysis, and another 

for visualizing uncertainty.   

 

For your convenience, we have created a Quick Start Guide and accompanying tutorial files 

which can be accessed from the Start Menu along with the rest of the software executables, or 

from the Help menu in the software. 

 

We hope that you find the software to be highly effective in your task of optimizing the 

monitoring of environmental data at your site.  We welcome all feature suggestions and 

comments at our website http://www.sampleoptimizer.com. 

http://www.sampleoptimizer.com/
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Environmental Security Technology Certification Program (ESTCP) 

 

As described on its website, ESTCP is a Department of Defense (DoD) program that promotes 

innovative, cost-effective environmental technologies through demonstration and validation at 

DoD sites.  ESTCPôs goal is to demonstrate and validate promising, innovative technologies that 

target the most urgent environmental needs of the DoD. These technologies provide a return on 

investment through cost savings and improved efficiency. 

 

In late 2005, ESTCP funded a project to demonstrate and evaluate SampleOptimizerÊ and 

SampleTrackerÊ on three DoD sites. The objective of this project was to demonstrate and 

validate the use of SampleOptimizerÊ and SampleTrackerÊ for reducing costs and improving 

effectiveness of LTM through adaptive assessment while achieving remediation goals.   

 

Substantial benefits are expected from the use of SampleOptimizerÊ and SampleTrackerÊ, 

including: 

 

1. Realizing significant cost savings by eliminating redundant data; 

 

2. Enabling new data to be assessed for significant deviations and other features of interest 

without substantial labor, a benefit that will become even greater as more facilities move 

into long-term monitoring modes and/or emerging sensor technologies produce larger 

volumes of data to be analyzed; and 

 

3. Providing a framework for effective implementation of an adaptive approach to 

monitoring, enabling limited resources to be efficiently directed where the greatest 

benefits are likely to be incurred. 

 

The version number of the software as used in the ESTCP project is 2.0. 

 

 

 

http://www.estcp.org/
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Site Suitability 
 

Before utilizing SampleOptimizerÊ to optimize the sampling on your site, it is important to 

review these baseline requirements and recommendations to make sure your site is suitable for 

use with this software suite.  Your site must have: 

 

¶ Sampling analytical results (data) which can be  

o Entered into a spreadsheet, or 

o Exported from a database into a spreadsheet 

 

¶ A minimum of 15 sampling locations (20 recommended). 

 

¶ A minimum of 4 sampling events of historical data per sampling location (8 

recommended) for temporal or spatio-temporal optimization.  Only one event is needed 

for spatial optimization. 

 

¶ See the SampleOptimizerÊ EDD for more information about the data requirements. 

 

It is recommended that SampleOptimizerÊ be used at sites where potential exists for negotiation 

of an alternate sampling plan with the relevant regulatory agency.  This is not necessary if only 

SampleTrackerÊ will be used, or if the site is not under regulatory guidance or control. 

 

In order to use SampleTrackerÊ on your site it must have: 

 

¶ One or more sampling locations with at least four samples per sampling location. 

 

¶ In order to enable mass metric tracking with SampleTrackerÊ via ModelBuilderÊ, your 

site must meet the minimum data density requirements required by SampleOptimizerÊ.   

 

¶ Please see the SampleTrackerÊ EDD for more information about the data requirements. 
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LTMO Process Flow 
 

 

The following is a flow chart describing the steps involved in LTMO using SampleOptimizerÊ 

and SampleTrackerÊ. 

 

 

 

 
Figure 1.  Overview of Optimization and Tracking Process 

 

 

Many of the above steps will be covered in detail later in this reference; below we provide details 

for steps not otherwise mentioned in this document. 
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GA Basics 
 

(Adapted from ñIntroduction to Genetic Algorithmsò) 

 

Genetic algorithms (GAôs) are inspired by Darwin's theory about evolution.  

 

The GA begins with a randomly-generated set of solutions (in SampleOptimizerÊ these are 

called plans), called a population. Each solution is composed of chromosomes; in 

SampleOptimizerÊ each chromosome represents a sampling decision for a sampling location.  

For example, a chromosome could say to ñSample MW-01 Semi-Annuallyò. 

 

Solutions from one population are taken and used to form a new population (also called a new 

generation). This is motivated by a hope that the new population will be better than the old one.  

Solutions which are selected to form new solutions (offspring) are selected according to their 

fitness - the more suitable they are the more chances they have to reproduce.  After selection, 

new solutions are created from the selected solutions through operations called mutation and 

crossover. 

 

After the fitness of every solution in a generation has been evaluated, SampleOptimizerÊ shows 

the population on a scatter plot referred to as the Pareto front or tradeoff curve.  This plot 

shows how well the solutions perform relative to two or more user-selected measures of fitness 

(objective functions). 

 

This process is automatically repeated until the appropriate number of generations has been 

completed. 

 

 
 

Figure 2.  GA Flowchart (created by Professor Chunmiao Zheng, U. of Alabama) 

  

http://www.obitko.com/tutorials/genetic-algorithms/index.php
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SampleOptimizerÊ 

 

¶ Create / Review Conceptual Site Model (CSM) 

o Before sending a set of data to the optimizer, it is necessary to check the site data.  

For example, with groundwater optimization, look for wells which are very close 

to each other and have similar screened intervals and make sure that they have 

similar hydraulic head readings and COC concentration values.  If there are large 

differences in such metrics between two or more sampling locations that are very 

close to each other, there could be a problem with the data. 

o If the CSM shows that your site has multiple hydraulic regions (for example, 

different aquifers), each region should be optimized separately. 

o Verify to the extent possible that the information is accurate (SiteID, coordinates, 

values, correct aquifer) 

o Make sure the data file being prepared for import is compliant with the applicable 

EDD (see SampleOptimizerÊ EDD and SampleTrackerÊ EDD) 

¶ Identify Spatial or Temporal Redundancy 

o After running the Optimizer, you should identify several potential new sampling 

plans from the tradeoff curve results generated by the SampleOptimizerÊ.  We 

recommend that you select plans which provide a level of interpolation accuracy 

(low error) acceptable to your regulator, at a lower annual cost than the current 

plan. 

o Similarly, after running the ModelBuilderÊ, you should identify any areas with 

unusually high uncertainty which may be of potential interest for characterization 

according to the siteôs monitoring objectives. 

¶ Develop New Sampling Plan With Regulatory Agency 

o Typically a regulator must approve changes to a siteôs sampling plan.  In order to 

justify a new reduced sampling plan, you will need to provide evidence (such as 

the plume images generated by the SampleOptimizerÊ) that reduction or 

elimination of sampling at certain locations, possibly in combination with 

installation of new sampling locations or increased sampling frequency at other 

locations, will maintain or improve the fulfillment of the monitoring program 

objectives. 
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SampleTrackerÊ 
 

¶ Results ï Do Anomalies of Concern exist? 

o The results of running SampleTrackerÊ may indicate that a COC was ñout-of-

boundsò at a location.  In such a case, it will be incumbent upon the analyst using 

the software to decide if an out-of-bounds COC is an ñAnomaly of Concernò 

needing further study and possible corrective action. 
 

o For example, a COC being found below the anticipated range will most likely not 

be a concern; a COC being found slightly above the anticipated range may not be 

a concern either. 
 

o Some possible reasons for anomalies: 

Á Real emergencies requiring a change in remediation strategy, such as a 

breakdown in a containment or treatment system. 

Á Bad data, due to errors during collection, faulty laboratory analysis, 

mislabeling of bottles, errant sample preparation, etc. 

Á Real differences between actuality and expectation that do not require 

action, but do require readjustment of oneôs CSM or expectation, possibly 

related to a real change in geochemistry or hydrology. 
 

¶ Evaluate & Take Corrective Action As Appropriate 

o After identifying one or more anomalies of concern, the analyst may need to 

notify additional parties who can decide if further action is appropriate, and what 

action will be needed. 
 

¶ Update ST Historical Data File 

o Lastly, at the end of each sampling event and the analysis thereof, the analyst 

needs to update the SampleTrackerÊ historical data file. 
 

o All appropriate samples should be added to the historical data file.  For example, 

samples which were found to be bad data should not be added. 
 

o If there are fewer than 8 historical samples for a given COC at a sampling 

location, it is recommended that new samples be added to the historical data until 

the requisite 8 historical samples have been gathered. 
 

o It is important that the analyst understands that adding additional samples to the 

historical data can cause the upper bound to increase over time if the added 

samples are of a high concentration. 

Á A good rule of thumb to use when deciding whether or not to add a sample 

to the historical data is if a concentration at a sampling location would 

almost certainly never be a concern for the foreseeable future, then it can 

be safely added to the historical data ï otherwise it may be advisable to 

leave it out. 
 

o During periodic review, it is advisable to check if changes to the CSM should be 

reflected in the historical data.  For example, a value which was once thought to 

not be appropriate for the historical data could be added into it, and vice-versa, as 

appropriate for the ñnewò groundwater understanding. 
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Installation 

Requirements 
 

Computer requirements: Windows XP or Vista, 1 GB RAM (2 GB preferred), 1.5 GHz single-

core processor (3.0 GHz dual-core preferred).  The installer must be run from a user login with at 

least power-user permissions. 
 

To use SampleOptimizerÊ 2.0, you must have a valid license file (.inst). 

 

Currently the software is only available for Microsoft Windows XP and Vista.  Operation under 

Windows 7 is likely but has not been fully tested.  In addition, you must have Sun Java JRE 6.0 

or better installed, as well as Microsoft .NET runtime 3.5 or better.  Please refer to Appendix A 

for more information on downloading those tools if you donôt already have them installed. 

 

Running the Installer 
 

Simply double-click on the installer file, SampleOptimizerSetup.msi when you have it 

downloaded and have a license file (which has an .inst extension) ready. 
 

Running the Software 
 

 
Figure 3.  Running the Software (shown in Vista) 

 

Upon running either SampleOptimizerÊ or SampleTrackerÊ for the first time, you will be 

prompted to input your license file (ends in .inst).  You will not be able to proceed unless your 

license is validated by Summitôs validation server.  This procedure sends no personally-

identifiable information and is conducted over a secure https connection.  Please keep this 

license file in a safe location, as it will be required to re-install the software. 
 

Please note that per the terms of your retail license you will only be able to install the software 

on the number of machines for which licenses were purchased.  Multiple-boot systems require a 

license for each OS installation. 
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Tips and Tricks 
 

Tool Tips 

 

If you see an option in the software and are unsure about it, allow your mouse cursor to hover 

over it for a few seconds and a ñTool tipò will pop up and give you more information about that 

option. 

 

Help Menu 

 

At any time, you may access the Help Menu from which the user can open this Reference, the 

Quick Start, or the product web site. 

 

 

Figure 4.  Help Menu 
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SampleOptimizerÊ 
 

Getting Started 
 

Before you begin using SampleOptimizerÊ, you will need a set of historical data to work with.  

The format currently supported for data input & output is .csv.  CSV is a universal, standard, 

non-proprietary, and royalty-free format supported by nearly all spreadsheet and database 

software including Microsoftôs Excel
 TM

 & Access
 TM

, and OpenOffice.orgôs free Calc and Base.  

It is very simple and CSV files can even be easily created by hand using a text editor such as 

Microsoftôs Notepad. 

 

Overview 
 

SampleOptimizerÊ strives to answer the following question: 

 

How should this site be sampled in the future, in order to  

best fulfill our goals without spending more than is needed? 

 

In this process, SampleOptimizerÊ looks at a siteôs past data and makes decisions based on the 

assumption that overall trends in the past will continue into the future.  For LTMO sites, this is 

very likely to be a valid assumption. 

 

In order to determine if there is a sufficient amount of information about the site, the siteôs 

physical characteristics (e.g., hydrogeology) and regulatory constraints, as well as professional 

engineering judgment must be used together with the sampling data, plume maps, and other 

information provided by SampleOptimizerÊ in order to make an overall determination as to the 

best course of future action at a site. 
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Electronic Data Deliverable (EDD) 

 

The EDD for SampleOptimizerÊ is designed to import site-specific sampling data in a simple 

cross-tab format.  Here is an example. 

 
Date SiteID EastCoordinate NorthCoordinate Benzene Chlorobenzene 

4/12/1995 BL003 222.5 768 4.10 240.00 

4/12/1995 OS004 256 720.75 0.90 20.2 

4/12/1995 OS003 441 6 1.20 180.30 

4/12/1995 OS005 517.25 449 0.01  

3/13/1996 MWSL001 846 727 2.70 8.20 

Figure 5.  Example SampleOptimizerÊ Data File 

 

The first four columns (Date, SiteID, EastCoordinate, and NorthCoordinate) must have those 

exact column names in that exact order.  Add or remove columns to the right of NorthCoordinate 

based on the actual number of COCôs.  COC column names can be anything you wish, but there 

cannot be more than one column with the exact same name.  Also, for ease of display, itôs best to 

keep COC name lengths to a minimum.  For example, use ñMTBE (ppb)ò rather than ñMethyl 

tertiary butyl ether (parts per billion)ò. 

 

Important! Each COCôs units must be consistent within that COC.  Different 

COCôs can have different units, however, since they are analyzed 

individually by the interpolation model.  For example, in Figure 5, 

benzene could be in ɛg/l, while chlorobenzene could be in mg/L. 

 

The coordinate system must remain constant throughout the siteôs data, and only one sampling 

location is allowed per EastCoordinate, NorthCoordinate pair.  The program does not impose a 

minimum separation distance between locations as long as they are not numerically identical. 

 

If your data contains two or more samples for a sampling location at a given time, you must 

decide which value you choose to input to SampleOptimizerÊ.  Possible choices include the 

minimum, maximum, or average of the multiple samples.  Here are some general 

recommendations: 

 

¶ Average regular and field duplicate data values if neither value is an obvious outlier and 

the samples are equally within the working range of the analytical method. 
 

¶ Do not average in quality assurance (QA) samples, usually labeled ñLab Replicateò or 

ñDUPò.  Often, such values are not comparable and should therefore be ignored. 
 

¶ If both values are non-detects with different reporting limits, use the result with the lower 

reporting limit (RL). 
 

¶ If one value is a non-detect with a ñtypicalò RL and the other a value, average half the RL 

and the value. 
 

¶ If one value is a non-detect with a high RL and the other a value, take the value. 
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Report Dates 
 

Sample dates must be arranged into discrete sampling events and labeled with one report date per 

sampling event, since the software will internally reference the data in quarters.  This convention 

was chosen because sites are usually sampled relative to the quarters in each year. 

 

Please note that only one report date per quarter is allowed and only one sample per COC 

per location per quarter is allowed.  If the input data do not follow these requirements, the 

software will display an error message explaining the source of the problem, and the data file 

must be corrected before proceeding. 

 

For reference, the quarter cutoff dates, which are inclusive of the end points, are as follows: 

 

Q1: January 1 to March 31  Q2: April 1 to June 30 

Q3: July 1 to September 30  Q4: October 1 to December 31 

 

Non-Detects in SampleOptimizerÊ 

 

¶ Zero values are not allowed.  Instead, non-detect data with typical RLs should be 

replaced by a numerical substitute value which should be consistent for each COC.  

While there is no perfect non-detect substitute value, 1/20
th
 RL has been found to work 

acceptably in many cases. 

 

¶ If  the typical RLs vary from event to event, using a common value such as 1/20
th
 the 

median of typical RLs across events may be useful. 
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EDD Notes 
 

¶ The maximum number of significant digits supported for coordinates and sample values 

is 15, in the approximate range of -1.79769E308 to 1.79769E308.  Additionally, in 

extreme cases where the site area is astronomically large from a numerical standpoint, the 

software will show an error message that optimization will not be possible.  This should 

never happen in practical circumstances. 

¶ The supported date formats are as follows: 

o Leading zeros are OK as in 05/05/2007 

o 4-digit and 2-digit years are both supported 

o 5/15/2007 

o 5/15/2007  1:00:00 PM (Note: the time will be ignored) 

o 5/15/2007  13:00  (Note: the time will be ignored) 

o 15-May-07 

¶ If a value for a COC is missing, simply leave the appropriate cell blank as in the example 

above. 

¶ If you are using Excel to create the CSV, all columns & rows outside the valid data 

should have an ñEdit > Clear > Allò done to them, or else the exported CSV may contain 

a potentially large number of blank rows and/or columns which will cause errors during 

the data import process.  You can check for excess columns/rows by opening the CSV in 

a text editor such as Microsoft Windowsô Notepad. 
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Spatial Data, Temporal Data, and Spatio-Temporal Data 

 

There are two categories of data which SampleOptimizerÊ can work with: spatial, and 

temporal/spatio-temporal.  Spatial data is a set of COC concentration values for sampling 

locations at one reporting date.  Temporal and spatio-temporal data contain COC concentration 

values for sampling locations at multiple reporting dates. 

 

Depending on the available data for the chosen sampling locations at your site, it may be 

possible to perform either a spatial analysis or a temporal/spatio-temporal analysis. 

 

If a spatial analysis is desired, a representative sampling event must be chosen from the historical 

data, stored in a properly formatted .csv file, and then input into the optimizer.  Alternatively, 

you may choose to create an artificial sampling event based on the historical data, perhaps 

averaging locationsô historical values or using the last value at each location, in order to create a 

representative sample value for each sampling location within the newly created artificial 

sampling event. 

 

If a spatio-temporal or temporal analysis is desired, a properly formatted .csv file containing at 

least 4 or more representative sampling events must be input into the optimizer.  These may be 

the actual historical data, or, at the discretion of the user, may be artificial sampling events 

constructed based on the actual historical data. 

 

For further guidance on the construction of artificial sampling events, please contact one of our 

optimization consultants. 
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Loading Data 

 

Upon running SampleOptimizerÊ, you will be presented with the following screen. 

 

If you already have a saved .site file, you can load it with the File menu, drag it into the window 

area, or simply double-click on it. 

 

To start a new site analysis, either click the Load button and select the data file, or simply drag 

the data file onto the window area.  Alternatively, you can right-click on a .csv data file you have 

prepared, select ñOpen Withò, and then choose SampleOptimizerÊ. 

 

 

 
Figure 6.  SampleOptimizerÊ Initial Screen 
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If your data file is not in the correct format, you will receive an error dialog explaining the 

condition.  You can then fix the problem in a spreadsheet editor program or text editor, and try to 

import it again. 

 

If data density checking is enabled in Application Options (by default it is disabled), when you 

attempt to load a new data file which has low data density, you will see a warning screen which 

explains the source of the warning as well as options on how to proceed.  Please note that if there 

are multiple sampling locations and/or COCôs with low data density, you will see multiple 

confirmation dialogs unless you choose either the ñYes to allò or ñNo to allò options. 

 

 
Figure 7.  Data Density Warning Dialog 

 
After successfully loading a data file or opening a saved site file, you will see the Data Summary 

screen.  In Figure 8, a spatial dataset has been loaded. 
 

 
Figure 8.  Spatial Data Loaded 
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If sampling locations, contaminants, or sampling events have been excluded from the analysis 

because of lack of sufficient data density, their samples will be grayed out.  Figure 9 shows an 

example of a temporal dataset which has been loaded, but with some disabled samples (locations 

RW-03, RW-08, and RW-11 have been disabled). 

 

 

 
Figure 9.  Temporal Dataset Loaded (with exclusions) 

 

 

Data Density Requirements 

 

For temporal/spatio-temporal analysis, SampleOptimizerÊ will not include sampling locations in 

the analysis which have fewer than 4 samples, and for spatial and temporal/spatio-temporal 

analysis will not include sampling events which have fewer than 15 samples. 
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Application Options 

 

For advanced users, there are some configuration options (in the Edit  menu under Application 

Options) which are available to be configured during most phases of the software operation.   

 

 
Figure 10.  Application Options. 

 

¶ Data input density warning (disabled by default) 

o If enabled, will warn the user when 15 to 19 (inclusive) valid, non-excluded 

samples are available in a sampling event, or for temporal/spatio-temporal 

analysis if between 4 and 7 (inclusive) valid, non-excluded samples are available 

for a sampling location.  Normally the software includes such events or locations 

without warning, but the user can choose to be notified and have the opportunity 

to exclude such events or locations from the analysis. 

¶ Append run title (enabled by default) 

o Appends the run title to the current date and site name when auto-generating file 

names for image and data exporting. 

¶ SampleOptimizerÊ population cache (disabled by default) 

o This is an experimental (beta) feature which in some cases has been found to 

reduce the computational time of the optimization process.  However, this will 

increase memory consumption and may cause other tasks on your computer to 

slow down severely, especially if your installed memory is low and/or the 

population size is too large.  The program may even crash if it runs out of 

memory.  Therefore, use this feature at your own risk.  Note: this feature does not 

affect model or plume image computation. 

 

 



SampleOptimizerÊ & SampleTrackerÊ 2.0 Reference Manual  

Page 25 of 84 

Settings 

 

Next, in the Settings tab, you will see the following screen when performing a spatial 

optimization: 

 

 

 
Figure 11.  Spatial Data Settings 

 

 

Please note that when working with a temporal/spatio-temporal dataset, spatial domain will be 

disabled, while temporal and spatio-temporal domains will be enabled. 

 

This is the screen where you will be able to edit the settings for the optimization, and use 

ModelBuilderÊ to optimize the parameters for the model.  The defaults will usually be a good 

place to start, and most or all settings will not have to be changed in most cases. 

 

You should use the Visualize Model tool to verify that the plume interpolation is acceptable 

before performing an optimization.  If you want to increase the resolution of the images 

generated, see ModelBuilderÊ Settings and increase the setting for # of vertical slices. 
























































































































